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Introduction
SAS is a statistical software package used extensively in many statistical fields, including econometrics. It is installed on most general lab computers, as of Oct. 2006, these labs are listed below.  The most recent version is 9.1.3. Showker labs has both 9.1.3 and the previous version 8.2. It is suggested that you use the most recent version, 9.1.3.
Carrier 101  

HHS2037 

Hillside PC 

Maury 203  
Zane Showker 206-208
Chandler

Learning to use SAS involves learning the syntax of the program, that is, the rules of creating and executing a program as well as learning how to use the software in the windows environment.  SAS can operate in either a batch mode or in an interactive mode of Windows applications.  This guide will focus on batch mode and the basics of writing and executing a program of commands.  
In batch mode, SAS executes your instructions line-by-line from a command file. You then examine the resulting output and make any necessary changes. This approach is not as easy to use as interactive software, but it conserves computing resources to apply raw processing power to the statistical task at hand.

The two basic steps for all SAS analyses are 1) writing the program and 2) executing the program. 

I. SAS for Windows: BASICS  
From the Start menu, go to Programs, and find SAS 9.1(English).  It may be located in the JMU Apps part of the start menu.  This will launch the program. As it comes up you will find several windows on the screen, each with a certain function. 

1)   The Programming windows

The windows that are used for SAS programming are the Program Editor, Log, and Output windows. 

a)  Editor Window: 
allows you to write, edit and submit SAS programs.  A SAS program consists of a list of commands telling SAS where to find the data that you want to analyze and what analysis you want to do on the data. 

b)  Log Window:  
displays messages from the SAS System. This is where you will find error messages telling you that SAS ran into an error in your program and can’t proceed.  

c)  Output Window: 
displays the output of your program.  

d)  Results Window: 
 helps you navigate the information in the Output Window.  Keep in mind that it contains nothing that isn’t already in the Output Window; therefore, we won’t be using it.

e)  Explorer Window:  
also a navigation tool that we can ignore for now. 

It is possible to have all of these windows, or a subset of them open at one time.  In fact, when you launch the program, you will have the LOG and the EDITOR windows open, as well as the Explorer window.  It will look like this:
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Once you run some procedures, SAS will open up the OUTPUT and RESULTS windows. 

II. THE BASICS OF PROGRAM FILES
You will create a program file in the Editor window.  The program file contains the SAS commands to carry out statistical analyses. For example, you can give a command that calculates the mean, standard deviation and other sample statistics for a list of variables.  Before you start writing code, it is suggested that you go to the FILE menu and choose SAVE.  Given the program a filename and the file extensions  .sas.  These program files are really quite small and are ascii text files.  You should save your files so that you can take them with you.
There are two important parts of the SAS program file: 
1)  the DATA Step:

· Read in data from text files, spreadsheets, SAS data set

· Calculate new variables based on existing variables in the data set

2)  PROC statements. (PROC stands for PROCEDURE)
· Organize your data, such as sorting and listing contents of the data set

· Analyze your data, such as estimating descriptive statistics and estimating a least squares regression equation.

SAS is rather picky about how a program file is constructed.  For example, every command must end with a semi-colon. If you forget this semi-colon, SAS keeps reading the code, line to line until it finds a semi-colon. This does not mean that every row in your program must end with a semi-colon because some command lines can wrap onto the next line. For example, the following commands tell SAS to calculate the correlation between the variables X and Y:

	PROC CORR; 

     VAR Y X;

RUN;


This could also be accomplished with the following code:

	PROC CORR;   VAR Y X;       RUN;


Also, the following code would also work:

	PROC 

   CORR;

VAR
Y X;

RUN;


 In each of the three above examples, SAS considers there to be three (3) lines of code.  

However, the following code will not work. It is like a run on sentence that makes no sense to SAS:
	PROC CORR 

VAR X Y

RUN;


SAS is also rather picky about the ordering of the commands. All commands that read in the DATA and create new variables must precede any of the PROC commands.
Let’s look at a sample program, one set up to analyze the housing price data in Table 4.1 of Ramanathan’s Introductory Econometrics.  The data are in a file named HOUSE.txt; a print out of this file appears below.
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199.9 1065 3 1.75

228 1254 3 2

235 1300 3 2

285 1577 4 2.5

239 1600 3 2

293 1750 4 2

285 1800 4 2.75

365 1870 4 2

295 1935 4 2.5

290 1948 4 2

385 2254 4 3

505 2600 3 2.5

425 2800 4 3

415 3000 4 3

 
This text datafile was created in Excel so that the values in each row are separated by tabs.  This is important information that SAS needs to know when reading the data file. 

Here is what the SAS command file looks like:

	OPTIONS LINESIZE=78; 

DATA whatever;

INFILE 'J:\HOUSE.TXT'   DELIMITER='09'x  firstobs=2;

INPUT   PRICE   SQFT   BED   BATH;

NEWPRICE = PRICE*100000;

PROC REG;

TITLE 'Housing Regression Using Square Feet';

MODEL PRICE = SQFT;

RUN;

PROC REG;

TITLE 'Housing Regression with New Price Variable';

MODEL NEWPRICE = SQFT;

RUN;


What this code does:  

1)  The first line tells SAS to make the output 78 columns wide, so it can easily be read on screen or printed to a printer.  
2)  The second line names the data set as "whatever".  When you name your data set, do not use spaces: “what ever” is bad, “whatever is good”.
3)  Look at the line that starts with "INFILE".  It tells SAS where to get the data. In this case it’s in a file called ‘HOUSE.TXT’ that is located on the J:\ drive.  The first line of the file HOUSE.TXT contains variable names; the actual numerical values start on the second line. Therefore, we tell SAS to start reading the data values in row 2 (firstobs=2).  

4)  The next line of the program starts with INPUT.  With this statement, you are telling SAS which names to assign to the columns of data.  SAS will not get the variable names from the first row of the datafile.  Variable names should be short (eight characters or fewer) and memorable, and should not contain any spaces or punctuation. 

5)  The next line generates a variable called NEWPRICE, which is equal to PRICE times 100,000. In the original data set, a value of 2.5 would apply to a house that sold for $250,000. NEWPRICE simply expresses the original values in more familiar dollar units.

6, 7, 8, and 9)  The command PROC REG tells SAS to run a regression.  A TITLE statement helps you keep track of the output. The MODEL statement is highly abbreviated, in that "MODEL PRICE = SQFT," tells SAS: "Run a linear regression with PRICE as the dependent variable and SQFT as the explanatory variable and include a constant term."  If you have more than one independent variable, separate the variable names with spaces  MODEL PRICE  = SQFT BED BATH;  
10, 11, 12, and 13) This block of code starts with another PROC REG.  It tells SAS to run a linear regression with NEWPRICE as the dependent variable and SQFT as the explanatory variable.   Note that the construction of NEWPRICE (or any other new variable) must appear before any of the PROC commands. 

You could accomplish the same steps by setting up a new DATA set using the SET command. This is demonstrated below.  Pay close attention to the construction of the data set named TWO.  It is set equal to the contents of ONE, and then a new variable NEWPRICE is added to it, so that TWO has one variable more than ONE.
	OPTIONS LINESIZE=78;

DATA whatever;

       INFILE 'a:\HOUSE.TXT'   DELIMITER='09'x  firstobs=2;

       INPUT   PRICE   SQFT   BEDRMS   BATHS;

PROC REG;

TITLE 'Regression Model of Housing Prices';

MODEL  PRICE = SQFT;

RUN;

DATA TWO;

        SET ONE;

NEWPRICE = PRICE*100000;

PROC REG;

TITLE 'Model Using New Price Variable';

MODEL NEWPRICE = SQFT;

RUN;


 III. CREATING A SAS PROGRAM
A. DATA SETS 
The easiest method for reading in data is to have SAS read it from a simple text file where the values in each row are separated by spaces.  

1)  If you create your data in Excel and save it as a text file, Excel will separate the values in a row with tabs, not spaces.  You must tell SAS that the values are delimited by tabs. The following INFILE statement will work:

infile 'c:\my documents\classes\filename.txt'  DELIMITER='09'x  firstobs=2;

If your data contained any commas or percentage signs, SAS won’t read the data correctly. Numbers as innocent as 4.5% and 300,183 need to be changed to 0.045 and 300183 to be correctly read by SAS. The best way to do this in Excel is to select the data, then choose Format Cells and apply the General format to all numbers that will be used by SAS. 

2)  You can leave your data in an Excel file (with filename extension .xls) and import it into SAS with the following commands using an example file named ex67.xls:

OPTIONS LINESIZE=78;

PROC IMPORT   DATAFILE="C:\MY DOCUMENTS\CLASSES\EC385\EX67.XLS"
     OUT=NEWDATA  replace;

RUN;

PROC CONTENTS;

RUN;

DATA TWO;

  SET NEWDATA;

lnX = log(X);

PROC   REG;

model y = lnx;

RUN;
Notice the use of double quotes around the path and the file name of your Excel file.  This code places the contents of the Excel spreadsheet into a SAS data set named NEWDATA. There is no need to tell SAS what is in the dataset….SAS will “talk” to Excel and get the information from the spreadsheet.  Specifically, SAS look in the first row of the spreadsheet to get the variable names.  Therefore, it is important that your spreadsheet be very neat, with variable names in the first row and data that begin in the second row. You should have no blank rows in your data set.  Basically it should be a simple matrix of numbers in contiguous rows and columns and variable names in the first row. 

Since the importing of the spreadsheet involves a PROC statement (“PROC IMPORT”), it is necessary to create a new data set and put the contents into it so that you can now create new variables.  In the example above, the log of X is created, assuming X was a variable in the spreadsheet. The variable lnx will be created and placed in the dataset named TWO, which will also contain all the contents of NEWDATA (…which contains the contents of the spreadsheet!!)
B. CREATING AN ENTIRE SAS PROGRAM 

Above you have seen parts of a sample SAS program. In this section you will create an entire SAS program. 

Enter the SAS program (if you are not already in SAS) by going to the Start Menu in Windows, Programs, (or JMU Apps) and locating SAS 9.1 (English).  You  want to get into the Editor Window.  When launching SAS you will get an empty Editor window named “Editor – Untitled1”.  If you ever lose this, you can get back to it by clicking on the Editor button on the bottom bar, or by going to the View Menu and choosing “Enhanced Editor”.  You can start entering your program in the editor.  Once you are finished, you save it by going to the File menu and choosing Save.  You will be prompted for a file name and SAS will automatically give it a file extension of .sas.

Note: There are actually two editors in SAS: one titled “Program Editor” and the other “Enhanced Editor”.  When you launch SAS, it automatically gives you the Enhanced Editor in a window.  You can find the Program Editor from the View Menu.  Basically, the Program editor is an older version of the Enhanced editor. Enhanced Editor is better because it is “enhanced”!  It is designed to assist you in writing programs by using color codes that help you know where command lines start and stop (with a semi-colon).  

	OPTIONS LINESIZE=78; 

DATA HOUSE;

INFILE  'J:\house.txt'  DELIMITER='09'x  firstobs=2;

INPUT   PRICE   SQFT   BEDRMS   BATHS;

PROC  SORT;

     BY   PRICE;

RUN;

PROC   PRINT;

   TITLE 'TABLE 4.1 HOUSE PRICES';

RUN;

PROC MEANS;

   VAR   PRICE   SQFT   BEDRMS   BATHS;

RUN;

PROC REG;

   TITLE 'Housing Regression Equation';

   MODEL PRICE = SQFT;

RUN;

PROC REG;

   TITLE 'Multiple Regression Housing Equation';

   MODEL PRICE = SQFT  BEDRMS  BATHS;

RUN;


IV. PROGRAM EXECUTION
So far, you haven't actually computed any statistics or regressions. You have created a program of commands in the Editor window. Now you have to execute it using the SAS command.  You can submit the program in a number of ways

On the toobar, there is a button on the right side of a little “person running”.  It is the third button from the right along the toobar at the top of the screen.  Click this button and SAS will execute the commands in your program file (note: you must have the editor window active for this to work:  look at the top of the window for a bright blue bar that tells you which window is active).  SAS will execute your program.

When it is done, you will have information in the LOG and the OUTPUT windows.  The LOG file is important only for finding errors in your program code. The output from the PROCedures will appear in the OUTPUT window.  

V.  EXAMINING THE RESULTS

1)  Check the LOG window for errors.  There will be a lot of junk in this file. Remember, it has no results in it. Scroll through the window looking for ERROR statements.  If you do have an error, you won’t necessarily have detailed information on what errors you have made.  You will have to go back to the program in the Editor window and look for errors like misspelled words and missing semi-colons.

2)  Next examine your results by clicking on the OUTPUT window

It is always a good idea to examine output files before you print because you may have errors in your program file that prevents SAS from carrying out the appropriate commands. Scroll through the output. (If you have errors in your program, you may not even any results in the OUTPUT window.) 

VI.  RUNNING THE PROGRAM AGAIN

If you found an error in the program, or re-run it for some other reason (suppose you hit the SUBMIT icon (little man running) over and over.  Each time you submit the program, SAS adds more information to the LOG and OUTPUT files, appending it to the bottom of these files.  So, your OUTPUT and LOG windows can get clogged up.  If you re-submit your program for execution, first open the LOG window, go to the EDIT menu and choose Clear All. This will completely empty this window, making it ready to receive information from a new run.  Then open the OUTPUT window, go to the EDIT menu and choose Clear All.  You can now go to the Editor window that contains your program and give the submit command.

VII. PRINTING YOUR RESULTS

1)  NEW!  HTML output.  If you want, you can set up SAS dump all of the output into HTML formatted Tables. 
Go to the TOOLS menu, choose OPTIONS, from here choose PREFERENCES.  In this dialog box, click on the RESULTS tab, choose Create HTML  as shown below.  Style is your choice, but Festival works well from a size and color prespective.  The dialog box should look like this:
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With this setup, you can run your program, doing so will create another window, called the Results Viewer.  From here you can print out these tables as you see it.  Alternatively, you can right click on one of these tables in the Results Viewer and choose, EXPORT TO EXCEL to get the output dumped into Excel.

2)  The old way of printing your output involves clicking on the OUTPUT window.  Once OUTPUT is the active window, go to the FILE menu and choose PRINT.  

Suppose you are not ready to print (or don’t have any JAC $ to print).  You can cut and paste the output into a text/WORD document, that you can take with you and print at home or wherever.  You can also open it up in Word and shrink it down by removing multiple carriage returns, and choose a small font. 
VIII. EXTENSIONS OF BASIC PROCEDURES 

SAS can perform many operations other than basic regression analysis. Its "extensibility" is considered one of its major virtues in commercial applications. We will be using a few extensions of basic regression procedures. Here are the most important ones, with the command lines used to invoke them:
1.   Creating Plots  (PROC GPLOT):

When a graph is created with PROC  GPLOT, a new window opens up containing the graph.  Any of these graphs can be cut and pasted into WORD by right clicking on the graph in the graph window, choose edit, copy.  Then get into WORD and to a PASTE command. 

The following code will construct a X-Y scatterplot of red dots including a legend.
symbol1 i=none v=dot c=black;

proc gplot;

label totsat=’avg sat (math + verbal)’

     exppp=’expenditures per pupil’;
  plot  totsat*exppp=state ;

run;

To Plot a the X-Y values and plot the least squares regression line, try this code:

proc reg;

  model totsat = exppp;

  plot totsat*exppp;

  run;
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2. To conduct an ordinary least squares regression, forcing the constant term to zero so that the equation has no intercept:

PROC REG;
MODEL YVAR = XVAR  /  NOINT;

3. To calculate the Durbin-Watson statistic to test for serial correlation:

PROC REG;
MODEL YVAR = XVAR  / DW;

To calculate the p-value for the Durbin-Watson statistic:
PROC AUTOREG;
MODEL YVAR = XVAR  / DWPROB;
4. To run a logistic (logit) model with a qualitative dependent variable:

PROC LOGISTIC DESCENDING;
MODEL YVAR = XVAR;

5. To run a model correcting for first-order serial correlation:

PROC AUTOREG;
MODEL YVAR = XVAR  / NLAG=1;

6. After a regression, to save residuals for further analysis (note that data must be sorted before any regressions are run):

PROC SORT;

BY YEAR;

PROC REG;

MODEL YVAR = XVAR;

OUTPUT OUT=STUFF  RESIDUAL=E;

DATA TWO;

MERGE ONE STUFF;

BY YEAR;

E2 = E**2;  (this creates a variable of squared residuals). 

[Then include any statements you want using E as a variable, where E is the residual for each observation.]

7. To conduct a standard t-test on differences of means:

(Note: This test involves looking at rents paid by minority and non-minority apartment dwellers in a given city. PROC TTEST invokes the T-test procedure. It divides the sample into classes by minority status (the CLASS MINORITY statement) and it specifies that rent is the variable of interest (VAR RENT) statement.)

OPTIONS LINESIZE=78;

DATA RENTSET;

INFILE 'c:\my documents\classes\ec385\datax.dat' DELIMITER='09'x firstobs=2;

input NAME RENT MINORITY;

PROC TTEST;

TITLE 'T-TEST OF RENT BY MINORITY STATUS';

CLASS MINORITY;

VAR RENT;

RUN; 

This is the data file named HOUSE.TXT.  Notice the variable names in the first row and data values that follow. We need to write code to tell SAS where this file is, and what is in it.








_1170763692.xls
TEMP

		price		sqft		bedrms		baths

		199.9		1065		3		1.75

		228		1254		3		2

		235		1300		3		2

		285		1577		4		2.5

		239		1600		3		2

		293		1750		4		2

		285		1800		4		2.75

		365		1870		4		2

		295		1935		4		2.5

		290		1948		4		2

		385		2254		4		3

		505		2600		3		2.5

		425		2800		4		3

		415		3000		4		3






